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1

Introduction

The Thermo Scientific™ HAAKE™ RheoWin™ software is a computer program for controlling Thermo 
Scientific HAAKE rheometers and evaluating/analysing data measured with those devices.

This manual describes both the standard installation of the ThermoScientific HAAKE RheoWin 
software (hereinafter referred to as RheoWin) and the installation of RheoWin in conjunction with the 
21 CFR Part 11 tools. 

The reason for this is that, on the one hand, certain parts of RheoWin (such as the User Managment 
System) can also be used with a standard installation of RheoWin (i.e. without the 21 CFR Part 11 
tools), while, on the other hand, the 21 CFR Part 11 tools (User Management System, Audit Trail and 
Signature functionality) must already be considered and configured during the installation of 
RheoWin.

Those parts of the installation that are only required and/or available when the 21 CFR Part 11 tools 
are installed are marked accordingly in the text. This concerns certain passages of Chapter 3 
(Installation) and Chapter 4 (User management) as well as the entire Chapter 5 (Audit Trail) and 
Chapter 6 (Signatures and Security Settings).

This manual is based on RheoWin version 4.95.0000.

Note  The RheoWin software must be installed on a PC with a Microsoft™ Windows™ operating 
system before it can be used.

Note  For installing the RheoWin software a valid RheoWin product key is needed.

IMPORTANT  A RheoWin product key is a license to install RheoWin on one PC (only) and for 
controlling one rheometer (only). For evaluating RheoWin data on a second PC a special (lower 
priced) DataManager-Only product key can be ordered.
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2

Installation Requirements

This chapter describes the computer system requirements for RheoWin 4.95.0000 and lists the devices 
that are supported by RheoWin 4.95.0000.

Computer system (PC) requirements
Certain requirements regarding the PC hardware and the PC operating system must be fulfilled in 
order for the HAAKE RheoWin installation to be successful and in order for RheoWin to be able to 
communicate with the various HAAKE rheometers, viscometers and temperature control systems.

Operating systems requirements

The HAAKE RheoWin software only runs on a PC with a Microsoft Windows operating system.

RheoWin 4.95.0000 has been tested to run under the following Windows operating systems:

• Microsoft Windows 10, 32-bit or 64-bit.

• Microsoft Windows 11, 64-bit (a 32-bit version of Windows 11 does not exist).

RheoWin 4.95.0000 does not run and/or is not supported and/or has not been tested under the 
following Windows operating systems:

• Windows 3.x and Windows NT 3.x.

• Windows 95, Windows 98 and Windows 98 SE, Windows ME.

• Windows NT 4.0 and Windows 2000.

• Microsoft Windows XP, 32-bit, with or without Service pack 1, 2 or 3.

• Microsoft Windows Vista, 32-bit or 64-bit, with or without Service pack 1 or 2.

• Microsoft Windows 7, 32-bit or 64-bit, with or without Service pack 1.

• Microsoft Windows 8(.1), 32-bit or 64-bit.

Note  For Windows “N” versions the installation of the additional “Windows Media Feature Pack” 
is obligatory.
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PC hardware requirements

No special PC is required for the convenient use of RheoWin. A PC meeting the requirements of the 
respective operating system for an office PC is fully suitable for the purpose.

As of April 2024, the following configuration is recommended:

• At least 8 GB RAM of main memory.

• A hard disk with a minimum of 2 GB available free space (or 10 GB if the RheoScope 1 or the 
RheoScope Module or another camera is used).

• An USB interface or internet connection for access to the installation files.

• A 24” (or larger) monitor with a resolution of 1920x1080 pixel (a minimum resolution of 
1152x864 pixels is mandatory).

• A keyboard and a mouse.

For the communication with a viscometer or a rheometer and with temperature control systems 
(circulators), cameras, etc., the following ports are required:

• For all HAAKE MARS rheometers:

 Ethernet TCP/IP interface 1.

 Serial (RS232) interface (or a USB interface in combination with an USB to RS232 adapter), 
for older temperature control systems (circulators),

 USB interface for newer temperature control systems (circulators).

 6-pin IEEE 1394a interface for the RheoScope module IEEE 1394 Firewire camera. 
We recommend the use of a PC with an IEEE 1394 interface which is integrated on the PC 
mainboard or the use of the IEEE 1394 interface card that Thermo Fisher Scientific supplies 
as an optional accessory.

 USB 3.0 interface for the RheoScope module USB camera.

 USB interface for a WDM compatible camera (WebCam).

• For the HAAKE Viscotester iQ rheometer:

 Ethernet TCP/IP interface 1.

• For all other (older) rheometers and viscometers:

 A serial (RS232) port or a USB port with an USB to RS232 adapter for the rheometer or 
viscometer.

 A serial (RS232) port or a USB port with an USB to RS232 adapter for older temperature 
control systems (circulators).

1 Two Ethernet TCP/IP ports are required if it is intended to also connect the PC on which RheoWin is installed to a 
network (corporate network or Internet)
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Windows access privileges requirements

• Directories under Windows 10 and Windows 11 (English and other language versions)

 C:\Users\Public\Public Documents\Thermo\RheoWin 
(or C:\Users\Public\Documents\Thermo\RheoWin depending on the representation in 
Windows Explorer.)

 C:\ProgramData\Thermo\RheoWin

• Directories under Windows 10 and Windows 11 (German version)

 C:\Benutzer\Öffentlich\Öffentliche Dokumente\Thermo\RheoWin

 C:\ProgramData\Thermo\RheoWin

• Windows registry key (all Windows versions)

 HKEY_USERS\.DEFAULT\Software\Thermo\RheoWin

• For english and other language 32-bit Windows versions:

 C:\Program Files\Thermo\RheoWin

• For english and other language 64-bit Windows versions:

 C:\Program Files(x86)\Thermo\RheoWin

• For german 32-bit Windows versions:

 C:\Programme\Thermo\RheoWin

• For german 64-bit Windows versions

 C:\Programme(x86)\Thermo\RheoWin

After a successful installation, Windows users of the default Administrator Group and Power User 
Group should directly be able to use the RheoWin software. Windows users of the default User Group 
must be granted read and write access to the RheoWin folders and Windows registry key mentioned 
above by an administrator.

For more information on the directories and the files in those directories which RheoWin uses see 
“Installation directories” on page 51.

IMPORTANT  Both during the installation of RheoWin and during normal operation of the 
RheoWin software read and write privileges must be available for the following directories and 
subdirectories as well as for a certain Windows registry key:

IMPORTANT  During the installation of RheoWin unrestricted write privileges must be available for 
the following directory and all of its sub-directories. This means that Windows administrator 
privileges are needed for the installation of RheoWin.

Note  In case RheoWin does not run as intended after setting up RheoWin and Windows as 
described above, consult Appendix C, “Configuration of Windows permissions” of this manual for 
more detailed instructions on how to configure RheoWin specific Windows permissions
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Supported devices (rheometers, viscometers, circulators, etc.)
Table 1 lists the rheometers, viscometers, temperature control systems and circulators that can be 
controlled by RheoWin.

Older HAAKE devices that are not shown in the list above may be supported by earlier versions of 
RheoWin, see www.rheowin.com.

Compatibility between RheoWin versions
A newer RheoWin version can always read all data (*.rwd), job (*.rwj) and page (*.rwp) files as well as 
all template files of older versions (backward compatibility).

An older version of RheoWin can not import any data (*.rwd), job (*.rwj) and page (*.rwp) files or 
template files from newer versions (no forward compatibility).

Table 1. Devices that are supported by RheoWin 4.95.0000

Rheometer Viscometer Circulators Temperature control 
devices

MARS 60 Viscotester iQ SC150, AC200 MTMC (MARS)

MARS 40 Viscotester iQ Air PC300 UTMC

MARS iQ UTC

MARS iQ Air VT D, VT E ACCEL CTC

MARS III

MARS II RotoVisco 1 Dynamax Rheonaut

MARS I RheoScope

RheoStress 6000 VT550 DC5, DC30, DC50

RheoStress 3000 Phoenix TC501a

a Drivers for these older devices are available on special request only.

RheoStress 600 F6, N6, F8, N8

RheoStress 300

RheoStress 1

Note  A RheoWin product key is always device-specific, i.e. only the software driver (the link 
between RheoWin and the device, so to say) for a specific rheometer or a viscometer model is 
installed. The drivers for temperature control systems, circulators and other ancillary equipment 
that are compatible with the installed rheometer or viscometer can be selected, if required, during 
installation.

Note  Once a file has been opened and saved by a newer RheoWin version it can not be opened by 
any older version anymore.

www.rheowin.com
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3

Installation

This chapter describes both the standard installation of HAAKE RheoWin (that is without the 21 CFR 
part 11 tools) as well as the installation of HAAKE RheoWin in combination with the 21 CFR part 11 
tools.

First Installation of RheoWin
RheoWin 4.95.0000 can only be installed parallel to an existing installation of an older version of 
RheoWin when the major version numbers of the individual versions are different. 

This means that RheoWin 4.95.0000 can be installed parallel to RheoWin 3.xx.xxxx and/or RheoWin 
2.xx, but not parallel to RheoWin 4.7x.xxxx or RheoWin 4.8x.xxxx, etc.

RheoWin 4.xx.xxxx, RheoWin 3.xx.xxxx and RheoWin 2.xx must always be installed in different 
directories.

Only one version of RheoWin can run on one PC at the same time.

Update Installation of RheoWin
RheoWin 4.95.0000 can be installed without deinstalling the previously installed older version, as long 
as the older version was RheoWin 4.20.0000 or newer. In this case the settings of the previously 
installed version are automatically transfered to the new version.

An existing installation of RheoWin version 4.00.0000 to 4.10.00xx however must be deinstalled 
before RheoWin version 4.95.0000 or newer version can be installed. In this case it is not possible to 
transfer the settings from the previous version to the new version.

Note  The RheoWin software must be installed on a PC with a Microsoft™ Windows™ operating 
system before it can be used.

Note  For installing the RheoWin software a valid RheoWin product key is needed.

IMPORTANT  A RheoWin product key is a license to install RheoWin on one PC (only) and for 
controlling one rheometer (only). For evaluating RheoWin data on a second PC a special (lower 
priced) DataManager-Only product key can be ordered.
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RheoWin Installation Files
The RheoWin installation files are available from two different sources:

1. The installation files for the latest RheoWin version are available for download from the RheoWin 
web-site. 
Use the following link to access the RheoWin web-site: www.rheowin.com 

2. The RheoWin installation files can also be ordered separately on an USB flash drive.

Starting the installation
The Rheowin software must be installed before it can be used. It is recommended to reboot the 
computer prior to starting the installation.

The RheoWin setup should always be executed locally, that is from a local directory (into which the 
downloaded installation files were copied), or from the (optional) RheoWin USB flash drive inserted in 
a local USB port, on the PC on which RheoWin is to be installed. The installation files should not be 
copied to a network drive first and the installation started from there.

 To install RheoWin after downloading

1. After downloading the file rhw4950000_complete.zip from the RheoWin web-site at 
www.rheowin.com copy the .zip file into a new and empty directory on the PC on which 
RheoWin should be installed.

2. Unzip the rhw4950000_complete.zip file to extract the setup.exe program and other files.

3. Run the setup.exe program to start the installation.

 To install RheoWin from the (optional) RheoWin USB flash drive

1. Insert the RheoWin USB flash drive in a local USB port on the PC on which RheoWin should be 
installed.

2. Using the Windows Explorer navigate to the root directory of the USB flash drive.

3. In the root of the USB flash drive double-click on Start to display the USB flash drive start screen 
see Figure 1 on page 9 in the default web-browser.

Note  Under circumstances the RheoWin version on the USB flash drive may not be the latest 
version. 
It is recommended to always check the RheoWin web-site and download the latest version.

http://www.rheowin.com
http://www.rheowin.com
http://www.rheowin.com
http://www.rheowin.com
http://www.rheowin.com
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4. Click on the text (link) Install HAAKE RheoWin 4.95.0000 (see Figure 1 on page 9) to start the 
installation.

or (instead of step 2 to step 4 above)

5. Using the Windows Explorer navigate to the RheoWin directory of the USB flash drive.

6. Launch the Setup.exe program by double-clicking on it.

Figure 1. RheoWin USB flash drive start screen

The installation process

After starting the installation, the dialogue language for the installation process must be selected. This 
language is also automatically preseted as the RheoWin user-interface language. The RheoWin 
user-interface language can be changed at any time in the RheoWin software.

Figure 2. Choose setup language

As soon as this step is completed, the InstallShield Wizard is launched.
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The InstallShield Wizard will first extract and install a Microsoft Visual C++ Redistributable Package 
and then extract and install a Microsoft Access Database Engine Redistributable Package (which are 
both needed for certain parts of RheoWin to work).

The InstallShield Wizard will then extract the RheoWin program files and install them. This can take a 
relatively long time, depending on the computer configuration and the operating system.

Figure 3. Installation preparation
i

During the installation of RheoWin, it is first necessary to enter a valid product key (license key) for a 
measurement device or the Data Manager. When this action is completed, up to 19 additional product 
keys for other measurement devices and/or RheoWin modules (such as 21 CFR Part 11 tools, TTS, 
Spectra, MWD, etc.) can be entered.

Figure 4. Please note, enter product key

A RheoWin product key consists of the Company name, Serial number and Key. This information 
must be entered in the appropriate fields in the Registration dialog (see Figure 5). When entering the 
company name and serial number, please note that these are both case sensitive. Case sensitivity does 
not apply to the key itself. The complete key can be entered by cut & paste in the first key edit-field. 
By clicking on the Load keyfile button the complete product key information can be read from an 
appropriate key-file. 

Figure 5. Enter product key information

Other product keys can then be entered for other rheometers/viscometers or RheoWin modules, such 
as the 21 CFR Part 11 tools, in any sequence desired. The company name, serial number and key must 
always be entered completely for each product key.

This is, of course, not a valid key
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Figure 6. Enter another product key

Welcome dialog

Once all product keys are entered, the Welcome dialog will appear.

Figure 7. Welcome dialog

This window displays the following information: The RheoWin version number, serial number (of the 
first product key that was entered), measurement devices an optional modules selected for installationd 
and the software expiration date (the latter only applies to demo versions).
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Figure 8. License agreement

In the following dialogs, the various installation options must be configured.

Dialog customer information

This dialog allows to select whether the RheoWin software is to be installed only for the user currently 
logged-on to the operating system or for all users who logon to the computer (operating system).

Figure 9. Customer information

It is recommended to use the default setting Anyone who uses this computer (all users).
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Dialog choose destination location

This dialog provides the option to select the Destination Folder (directory) where RheoWin is to be 
installed. The dialog for the directory selection can be accessed by clicking on the Browse... button.

Figure 10. Choose destination location (folder)

It is recommended to use the default setting C:\Program Files\Thermo\RheoWin. Please note that 
the actual default directory depends on the operating system version (and language), see Appendix A, 
“Directories, files, registry” .

Dialog measuring geometry selection

This dialog provides the option to Install all available measuring geometries or to Manually select 
the measuring geometries that will be installed (in the next four windows). It is recommended to use 
the Manual select... option, that is to only install the measuring geometries that are actually used in 
conjunction with the rheometer. It always possible to remove measuring geometries from the list (in 
the RheoWin DeviceManager) at a later point in time.
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Figure 11. Measuring geometry selection

Dialog thermocontroller selection

In this dialog the thermocontrollers that are to be used with the rheometer or viscometer can be 
selected.

Figure 12. Thermocontroller selection

The Select all button can be used to select all the thermocontrollers for the installation.

Dialog circulator selection

In this dialog the circulators that are to be used with the rheometer or viscometer can be selected.
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Figure 13. Circulator selection

The Select all button can be used to select all the circulators for the installation.

Dialog program options selection

Various different program options can be selected in this dialog.

Figure 14. Program options selection

RheoWizard Intelligent user guidance for creating a job sequence.

QC-Mode Validation of analysis results.

SnapShot Quick information on an unknown substance.
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Dialog select features

In this dialog it can be selected which templates, sample files and help files will be installed. Starting 
from RheoWin version 4.60.0000 this dialog only contains the Help files entry, all example and 
template and media files are always installed automatically.

Figure 15. Select features

Dialog select program folder

In this dialog the program folder (in the Windows Start menu) can be selected in which short-cuts to 
the HAAKE RheoWin programs are to be created.

Figure 16. Select program folder
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It is recommended to use the default setting RheoWin.

Dialog select shortcuts

In this dialog it can be selected whether program shortcuts to the RheoWin programs should be 
created on the desktop and/or on the taskbar of the PC.

Figure 17. Select shortcuts

Dialog setup status

The actual installation will now be started. Relatively long waiting times can arise, depending on the 
computer configuration and the operating system.
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Figure 18. Setup status

Dialog HAAKE Audit Trail Database Configuration

This dialog is only displayed when the 21 CFR Part 11 tools are being installed. In the dialog certain 
settings for the Audit Trail Database can be defined.

Figure 19. HAAKE Audit Trail Database Configuration

Dialog installation complete

This dialog provides the option to read the ReadMe file and launch the application after the RheoWin 
installation is complete. It is strongly recommended to read the ReadMe file.

IMPORTANT  These settings can also be performed after the installation, but it essential that these 
must be made prior to the first launch of RheoWin. This in order to meet the requirements 
regarding of 21 CFR Part 11. For more information on the configuration of the Audit Trail, see 
Chapter 5, “Audit Trail.” 
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Figure 20. Installation complete

First program launch after new installation
The RheoWin Job Manager, Data Manager or User Manager can be started via the shortcuts in the 
start menu of the operating system, on the desktop or on the taskbar.

Standard installation (without 21 CFR Part 11 tools) 

If the program has been installed without the optional 21 CFR part 11 tools, the programs will start 
without the user having to log in to RheoWin. All program parts and menu entries are accessible. In 
this case the default account is automatically enabled (and login is disabled), see the Administration 
page (Figure 38 on page 35) of the RheoWin User Management System

To enable the user access control system, the Default Account must be disabled on the 
Administration page of the User management dialog. The RheoWin User Management System is 
described in detail in Chapter 4.

Installation with 21 CFR Part 11 tools 

In case RheoWin was installed with the optional 21 CFR Part 11 module, the Enter administrator 
password dialog (see Figure 21) is displayed once on the first launch of the Job, Data, or User 
Manager. The administrator must enter (define) a password for the administrator access here.

IMPORTANT  Before RheoWin is launched for the first time, the Audit Trail MUST be configured 
to meet the 21 CFR Part 11 requirements see Chapter 5, “Audit Trail.” In case the Audit Trail has 
not already been configured during the installation, this step must be performed at this stage.
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Figure 21. Enter administrator password

To meet the requirements of 21 CFR Part 11, a secure password must be set and entered here by the 
administrator. The password must be repeated in the Retype password edit field in order to confirm 
the password.

When this step is completed, the RheoWin login dialog is displayed. Here the administrator password 
that was defined just before (see Figure 21) must be entered.

Figure 22. Login for RheoWin

When the administrator password has been entered, the account information is shown regarding the 
current access.

Figure 23. Account information for Administrator

The RheoWin JobManager, DataManager or UserManager program will now be launched with the 
restricted privileges of a RheoWin administrator.

Settings for 21 CFR Part 11
The following paragraphs shows the settings that either have to be performed prior to the first launch 
of RheoWin or otherwise immediately after the first start of the RheoWin.

Note  Many of the menu and dialog items in the JobManager and DataManager are not accessible, 
with the default RheoWin administrator account, since the default RheoWin administrator is only 
granted the privileges necessary to configure RheoWin and the 21 CFR Part 11 tools. See “Users” 
on page 27 for more information.

Click here to make the password characters visible



 3 Installation
Settings for 21 CFR Part 11

Thermo Scientific HAAKE RheoWin installation and 21 CFR Part 11 configuration 21

Audit Trail

The configuration of the Audit Trail is described in detail in Chapter 5, “Audit Trail.” 

User management

The administrator has to assign access rights to those users who are to be granted access to the 
RheoWin software by using the User Management System.

The User Management System can be launched as a separate application directly from the Windows 
desktop or the Windows Start Menu, or from the Configuration menu of the RheoWin Job or Data 
Manager, respectively.

Each user can be allocated group rights or individual rights for access to and the operation of the 
RheoWin software. New groups with specific rights can be created at any time.

When the "21 CFR Part 11" tools are being added to an existing installation where the RheoWin User 
Management System has not been enabled, the User Management System must be activated manually. 
In case the "21 CFR Part 11" tools are installed in the course of the RheoWin installation, the User 
Management System will be enabled automatically.

The configuration of the User Management System is described in detail in Chapter 4, “User 
management system.” 

Signatures and storage settings

The RheoWin administrator must make the desired settings regarding signatures and special options 
for saving in order to ensure that the installation meets the 21 CFR Part 11 requirements.

The configuration of signatures and storage settings is described in detail in Chapter 6, “Signatures and 
security settings.” 

User settings for Job and Data Manager

All settings (that can be) made in the Configuration menu by using the Language, Units and Settings 
commands are stored individually for each RheoWin user.

If a user is not to be given the ability to change any of these settings, this can be specified via the 
assignment of appropriate privileges in the User Administration (siehe Chapter 4). The settings for a 
user must, however, be defined in the RheoWin software prior to disabling these privileges for this user.

To this end, the RheoWin software is launched using the access of the respective user to make the 
appropriate settings. After completion of this step, the software application has to be closed again. The 
RheoWin administrator then has to disable the relevant privileges for the settings regarding this user in 
the User Management System.

IMPORTANT  Before RheoWin is launched for the first time, the Audit Trail must be configured to 
meet the 21 CFR Part 11 requirements.
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Job settings

lf the user logged into the RheoWin software is to be entered automatically as the operator whenever a 
job is started, the Logon name check box must be enabled on the General page of the Identification / 
Notes dialog (see Figure 24). Thus, when a job is started, the currently logged-in user will be entered as 
the operator, even if another user is displayed in the definition of the job.

Figure 24. Identification automatic operator name

Adding devices or software modules to an existing installation
Additional rheometers/viscometers and/or RheoWin modules can conveniently be added to an existing 
installation at any later point in time.

 To modify the RheoWin installation (under Windows 10)

1. Click the Windows Start button on the Windows taskbar.

2. From the Start menu choose Settings.

3. In the Settings dialog select Apps.

4. In the Apps & features dialog scroll down the list of application until HAAKE RheoWin becomes 
visible, see Figure 26 on page 24.

5. Click on the list entry HAAKE RheoWin.

6. Click the Uninstall button to launch the HAAKE RheoWin Setup program.

7. In the HAAKE RheoWin Setup program select Modify and then click Next >, see Figure 25.

The RheoWin installation modification uses the same dialogs as the installation, see “The 
installation process” on page 9, starting with the Enter product key dialog, see Figure 5 on page 10.

8. By entering one or more keys, one or more RheoWin modules or one or more rheometers / 
viscometers or a combination of both can be added to the installation.

IMPORTANT  When the 21 CFR Part 11 tools are being added to an existing installation where 
the HAAKE User Management System was not been enabled yet, the User Management 
System must be activated manually. See “Administration” on page 34 in the chapter User 
management.
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Figure 25. Installation modification

Deinstallation of RheoWin
The RheoWin (de-)installation program can be started from the Windows Settings dialog.

 To deinstall RheoWin (under Windows 10)

1. Click the Windows Start button on the Windows taskbar.

2. From the Start menu choose Settings.

3. In the Settings dialog select Apps.

4. In the Apps & features dialog scroll down the list of application until HAAKE RheoWin becomes 
visible, see Figure 26.

5. Click on the list entry HAAKE RheoWin.

6. Click the Uninstall button to launch the HAAKE RheoWin Setup program.

7. In the HAAKE RheoWin Setup program select Remove and then click Next >, see Figure 27.

8. In the following dialog confirm that HAAKE RheoWin should really be deinstalled.
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Figure 26. Windows Apps & features dialog

Figure 27. Remove program

All RheoWin registry key entries and all (RheoWin) files that were installed by the RheoWin installer 
are removed (deleted) during the deinstallation process.

Only those files that were created (by users) after the installation of RheoWin are not removed. This, 
amongst others, concerns templates, measurement data files, etc. The latter must be deleted manually, 
if required. In this respect it should, by all means, be ensured that no jobs, data, etc. are deleted that are 
still required.
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4

User management system

The HAAKE User Management System allows for the implementation of an user access control 
mechanism for RheoWin.

The entire management of users, user privileges, passwords, password rules, etc. is handled by a 
separate program (UserManCfg.exe) which is integral part of every RheoWin installation.

The User Management System can either be launched as a separate application directly from the 
Windows desktop or the Windows Start Menu or from the Configuration menu of the RheoWin 
JobManager and the RheoWin DataManager.

All settings that are made in the User Management System are stored in a MS Access database file. This 
database file is password protected and therefore not accessible for Windows users. This means that 
only the RheoWin program has access to this database file. The ADO driver, etc., that RheoWin needs 
in order to access this database are installed automatically. The Microsoft Access application is not 
required.

When the 21 CFR Part 11 tools were installed as part of the RheoWin installation, the user access 
control is activated automatically, this because 21 CFR Part 11 strictly requires the use of an user access 
control mechanism.

Enabling user access control
The user access control is automatically activated in case of a RheoWin installation with the 21 CFR 
part tools. For a standard RheoWin installation the user access control is not activated.

Standard installation (without 21 CFR Part 11 tools)

For a standard RheoWin installation the user access control can be activated at any time as required. To 
this end, the User Account Management System is either launched directly or from the JobManager or 
DataManager.

Upon the initial launch of the User Administration System a password must be defined for the build-in 
Admin (Administrator) user account. The password must be entered twice to confirm it.

Note  For a standard RheoWin installation (i.e. without the 21 CFR part 11 tools), the user access 
control can be activated at any time when needed.
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Figure 28. Defining the Admin user account password

When this step is completed, the RheoWin login dialog will be displayed for the first time. In this 
dialog the password that was previously defined for the Admin user account must be entered in order 
to gain access to the User Management System.

Figure 29. RheoWin login 

After entering the password for the (Admin) user, the Account information for [user] dialog will 
display some basic information on this user account.

Figure 30. Account information for the (Admin) user

After clicking the OK button the User Account Management System is launched and can be 
configured as described in „User account management system settings“.

Installation with 21 CFR Part 11 tools

In case the 21 CFR Part 11 tools are installed as part of the RheoWin installation, the user account 
control is activated automatically and opened upon the initial launch of RheoWin (see 2.6.2.), this 
because 21 CFR Part 11 strictly requires the use of user access control mechanism.

User account management system settings
After launching the User Management System the dialog in Figure 31is displayed.

Click here to make the password characters visible
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Figure 31. User Management System; Users

The functionality of the five pages of this dialog is described in the following paragraphs.

Users

On the Users page a list of the currently defined users is displayed. The users Admin, Default and 
Service are predefined and can not be deleted.

The user Admin is a predefined (except for its password) user, with administrator privileges, who 

• can create, copy, modify and delete user accounts,

• can grant privileges to and withdraw privileges from users,

• can activate and deactivate user accounts,

• by default only has those (very restricted) privileges in RheoWin that are required to manage the 
application and user accounts. By default the Admin user can not, for example, create, modify or 
execute jobs or load data files. This in contrast to a Windows administrator user who normally has 
all privileges.

The Admin user account can neither be locked nor deactivated or deleted. However, the Admin user 
can, of course, change its own privileges as required.

The Default user is a "dummy" user whose account can be activated on the Administration page of the 
User Account Management System dialog. When the Default user account is active, the RheoWin 
login dialog is not displayed at program start-up. This means that an user login is not possible and that 
each person who has access to the PC on which RheoWin is installed can use RheoWin with the 
privileges that have been set for the Default user account. These privileges can be restricted by the 
RheoWin Admin user or any other user with the proper administrative privileges. By default, as part of 
a standard installation the Default user is granted all privileges.

The number of user accounts that can be setup is only limited by the maximum size of the database file 
in which all the User Account Management System settings are stored. For the maximum database file 
size of 2 Gb, thousand user accounts are not a problem.
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 Adding, editing, deleting and copying users

After clicking on the Edit, Add or Copy button, a dialog is displayed where the properties, status, 
privileges, etc., of a (new) user can be entered and edited.

Figure 32. Adding a user

On the Account page of the Add user, Edit user and Copy user dialog the following edit fields, 
options and status indicators are provided:

• Edit fields

 User name
When the 21 CFR Part 11 tools are installed, a user ID, normally consisting of the first and 
last name of the user, must be entered for each user. 
In case of a standard RheoWin installation, the user ID can be left blank, if required. 

 Job title
A job description can be entered in this field. This field can be left blank. 

 Loginname
A login name must be defined for each user. Without a login name, a user cannot log in to 
RheoWin. The login name is not case-sensitive: “Smith” is the same as “SMITH” or “smith“.

 Password
A password must be set for each user in case the 21 CFR Part 11 tools are installed. The 
password is case-sensitive: For example, "Password" is not the same as "password". The 
password must conform to the rules defined on the Passwords page of the HAAKE User 
Management System dialog. 
In case of standard RheoWin installation the password can be left blank, if required.
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 Confirm password
The password must be entered a second time in this field in order to confirm it.

• Options

 User must change password at next log-in 
This option must be enabled when the 21 CFR Part 11 tools are installed. In a standard 
RheoWin installation, this option should be enabled. The reason for this is that the password 
(for the initial login) is normally assigned by and communicated to the user by the RheoWin 
administrator. As the administrator, however, must not know the password of an user, the user 
must change her/his password at the next login into the application.

 User cannot change password
This option must be disabled when the 21 CFR Part 11 tools are installed. Every user must be 
able to regularly change her/his password. This is required by the password rules. 
In case of a standard RheoWin installation this option can be set as required.

 Password never expires 
This option must be disabled if the 21 CFR Part 11 tools are installed. Every user must 
regularly change her/his password. This is required by the password rules. 
In case of a standard RheoWin installation this option can be set as required.

 User can manage user accounts
This option must be disabled for all users except for the RheoWin administrators when the 21 
CFR Part 11 tools are installed.
In case of a standard RheoWin installation it is recommended to set this options to disabled.

 Account locked
With this option the account of a user can be locked or unlocked (by a RheoWin 
administrator).

• Status display

 Login errors
All errors recorded during login attempts are shown in this status display. A login error will 
result, for example, when a user does not enter his/her password correctly. 
The list of display errors can be deleted by clicking the Reset button.

 Login time
In this status display the users last login and logout date/time are shown. 
These values can be deleted by clicking the Reset button.

 Account information
In this status display the date/time when the user was added to the RheoWin UserManager 
and the date/time of the last change(s) of the properties of the user are displayed.

Defining user privileges

On the Privileges page of the Add user, Edit user and Copy user dialog, specific privileges (or rights) 
can be granted to each RheoWin user individually. For a list of all available privileges see Appendix B, 
“User privileges.” on page 55.
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Figure 33. User privileges

The privileges are displayed in the form of a hierarchical "tree" structure, in the Privilege selection 
box, on the right hand side of the dialog.

The individual privileges that are assigned to a user are marked by the  symbol, those that were not 
assigned are indicated by the  symbol.

By clicking on a  or  symbol in front of a privilege the assignment of single privilege or all the 
privileges contained in a branch of the tree can be changed.

By clicking on the Expand tree or Collapse tree button, all branches of the tree that are hierarchically 
below the marked position are expanded or collapsed, respectively.

To simplify the allocation of an identical set of privileges to multiple users, privileges groups may be 
used, see “Groups.” 

All available groups are displayed in the Group selection list on the left hand side of the dialog.

When an individual privilege (right) is withdrawn from a user that had been granted to that user 
through membership of a group, that user ceases to be a member of the group. However, all other 
privileges (rights) - including those of the now restricted group - are retained.

Groups

To simplify the creation of (many similar) user accounts, the RheoWin administrator can define 
Groups with a certain set of privileges (rights) and then assign a certain group to an user.
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The four groups Administrator, Level-1, Level-2 und Level-3 are predefined and part of the 
RheoWin installation. It is recommended to rename the cryptic (but neutral) group names Level 1, 
etc., as required.

Figure 34. User Management System; Groups

The four predefined groups have been designed as follows: 

• Administrator
A user of this group only has the typical administrator privileges that are needed to administer 
RheoWin. An administrator can setup users, default directories and other basic program settings. 
An administrator can not create, modify, delete and execute jobs, nor create, modify and delete 
templates nor evaluate data, etc. That means, an administrator is not supposed to actually use 
RheoWin in combination with the rheometer/viscometer for which the software is installed.

• Level-1
A user of this group has almost all privileges available except for the typical administrator 
privileges. He can make device settings, create, modify, delete and execute jobs, create, modify and 
delete templates and evaluate data, etc. 

• Level-2
A user of this group has the necessary privileges to modify and execute existing jobs, to evaluate 
data, etc., but he can not create new jobs.

• Level-3
A user of this group can (only) execute predefined jobs and evaluate data, etc. 

Depending on the specific requirements in a company the properties of the predefined groups can and 
should be modified.

The effective privileges of a user result from the combination of the privileges of all groups to which she 
belongs and her individual privileges.

In case a single privilege is withdrawn from a user that had previously been granted to him through 
membership of a group, this user ceases to be a member of this group. However, all his other privileges 
- including those of the now restricted group - are retained.
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The number of groups that can be setup is only limited by the maximum size of the database file in 
which all the User Account Management System settings are stored. For the maximum database file 
size of 2 Gb, thousand groups are not a problem.

By clicking on the Edit, Add or Copy button, a dialog is displayed in which the properties of a group 
can be viewed and edited.

Figure 35. Editing a group

The functionality and the content of the privileges tree is identical to that of the Edit users dialog, see 
„Defining user privileges“. In addition to the Group name, which must be defined, a Description of 
the group can be entered.

Passwords

When the 21 CFR Part 11 tools are installed, each user must have a login password. These passwords 
must conform to certain rules according to 11 CFR Part 21. These rules must be defined on the 
Password page of the HAAKE User Management System dialog (once).

In case of a standard RheoWin installation (i.e. without 21 CFR Part 11 tools), passwords and the rules 
for passwords can be used. However, this is not mandatory in this case.
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Figure 36. User Management System; Passwords

On the Passwords page the following password rules can be defined:

• Maximum password age
When the 21 CFR Part 11 tools are installed the option Expires in must be enabled . This means 
that the option Password never expires must not be enabled. The specified number of days may 
vary depending on the company, 90 days is a commonly used value.

• Minimum password age
This option determines how often the password can be changed. This setting can be adjusted as 
required.

• Password uniqueness
When the 21 CFR Part 11 tools are installed the option Save n passwords must be enabled . This 
means that the option Do not save passwords must not be enabled. When the option Save n 
passwords is enabled, the first password can be used again after n other passwords. The value of n 
= 10 is a commonly used value.

• Password characters
When the 21 CFR Part 11 tools are installed the option Minimum password length must be 
enabled . This means that the option Blank password allowed must not be enabled. A value of 6 
is commonly used for the minimum Character count. In order to ensure that passwords have a 
certain level of complexity, it is also possible to require that a password contains At least one 
alphabetic character and/or At least one numeric character and/or At least one lower case 
character and/or At least one upper case character and/or At least one special character by 
activating the corresponding option.

Accounts

When the 21 CFR Part 11 tools are installed certain logon rules must be defined . These rules must be 
defined on the Accounts page of the HAAKE User Management System dialog (once). 

In case of a standard RheoWin installation (i.e. without 21 CFR Part 11 tools), the logon rules can be 
used, but this is not mandatory in this case.
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Figure 37. User Management System; Accounts

On the Accounts page, the following logon rules can be defined:

• Bad logon attempts
When the 21 CFR Part 11 tools are installed the option Lock after n attempts must be 
enabled . The option No lockout must not be enabled. A common value for the maximum 
allowed number of invalid logon attempts is n = 3.

• Lockout duration
This option can be used to define whether a lockout due to failed logon attempts remains in 
effect until a RheoWin administrator unlocks the account or whether the lockout will only be 
active for a certain period of time. This time can be specified in the Duration input field.

• Account not used
This setting determines whether a user account is automatically locked after not being used for 
n days. The account can only be unlocked by a RheoWin administrator.

Administration

When the 21 CFR Part 11 tool are installed the option Activate default account and disable logon 
must stay deactivated.

In a standard RheoWin installation (i.e. without 21 CFR Part 11 tools), the option Activate default 
account and disable logon is always enabled. This means that the logon dialog will not be displayed 
when launching the RheoWin Job Manager or Data Manager. Any person who has access to the PC on 
which RheoWin is installed can use RheoWin with the privileges that have been set for the Default 
user account. If no changes have been made to the Default user account privileges, there are no 
restrictions.
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Figure 38. User Management System; Administration

In the Language box, the dialog language can be set for the HAAKE User Management Sytem dialog 
in the event that the User Administration was started as a separate program either directly from the 
Windows desktop or via the Windows Start menu. 

When the HAAKE User Management Sytem was launched via the Configuration menu of the 
RheoWin JobManager or DataManager, the language selection option will be locked and the same 
language as in the JobManager and DataManager will be used automatically.
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Audit Trail

The Audit Trail is part of the 21 CFR Part 11 tools and will only be installed if the 21 CFR Part 11 
tools are installed. In this case, the Audit Trail will automatically be activated immediately upon initial 
launch of RheoWin via the Job Manager, Data Manager or User Manager. The installation of 
RheoWin is also logged in the Audit Trail.

General information
The Audit Trail records all actions that a user performs on a measurement definition (i.e. a *.rwj job 
file), a (*.rwd) data file, etc. or any another parameter which is relevant for the data acquisition.

Logged actions are, for example, the opening, editing and saving of a measurement definition as well as 
each log-in and log-out of a user to or from the RheoWin Job Manager, Data Manager and User 
Manager (but not the operating system!) as well as the start of a measurement (job). When 
modifications are made to a measurement definition (job file), the changes regarding all relevant 
parameters are only logged when the measurement definition (*.rwj job file) is subsequently saved. 
Temporary changes are not saved, because jobs that are not saved cannot be executed.

The events to be logged are (strictly) defined in RheoWin itself. The Audit Trail tool only provides the 
functionality necessary to record all changes in a database.

In the event that the Audit Trail database can not be accessed (for example due to the interruption of a 
network connection to the Audit Trail database file), the logged data is stored in a temporary log file on 
the local PC. When the contact to the Audit Trail database is re-established, the information contained 
in temporarily stored log file is transferred to the Audit Trail database and then deleted. Every single set 
in the temporary log file contains a separate checksum, so that potential manipulations can be detected 
and marked as such in the database.

Two empty Audit Trail database files, one in Microsoft Access 97-2003 (.mdb) format, one in 
Microsoft Access 2007-2013 (.accdb) format, are part of the installation and can be used immediately 
afterwards without any further action required.

To use a SQL database, the user must have installed the appropriate client on her/his computer. For 
this purpose, the SQL server must be of version 6.5 or higher. 

Note  The Audit Trail can not be disabled once it is installed.

Note  In a standard RheoWin installation (i.e. without 21 CFR Part 11 tools), the Audit Trail tool 
is not installed and can, therefore, never be activated.



5 Audit Trail
Configuration

38 HAAKE RheoWin installation and 21 CFR Part 11 configuration Thermo Scientific

The Audit Trail module only checks and uses the installed ADO driver (MS Jet 4.0 or MS SQL client), 
i.e. it does not work with ODBC drivers.

Configuration
The configuration dialog for the Audit Trail database is automatically displayed at the end of the 
RheoWin installation (see Section 2.4), which makes the configuration process fast and easy. The 
configuration must be performed by a Windows system administrator.

In case the configuration is not possible as an integral part of the installation or when changes to the 
configuration are necessary at a later point in time, an authorized user can start the configuration 
program AuditTrailCfg.exe separately. The program is stored in the main RheoWin program directory 
(default directory C:\Program Files\Thermo\ RheoWin).

The initial configuration of the Audit Trail database must be performed prior to the initial launch of 
RheoWin (Job Manager, Data Manager or User Manager).

It is the responsibility of the customer or the system administrator to restrict the access rights for the 
Audit Trail configuration program using the tools of the operating system, i.e. to only allow the system 
administrator, for example, to execute this program.

An easy way to restrict access is to completely remove the configuration program from the RheoWin 
program folder and store it in a safe place (i.e. a place with restricted access).

The dialog automatically detects which drivers are installed on the PC and provides the option to 
choose between an Access or a SQL database file.

Access database

The MS Access database file HAAKEAuditTrail.mdb, which is installed in the RheoWin application 
data directory, see Installation directories, is stored in the MS Access 97 format. It can be converted to 
the MS Access 2000 or MS Access 2003 format, if required. 

The MS Access database file HAAKEAuditTrail.accdb, which is installed in the RheoWin application 
data directory, see Installation directories, is stored in the MS Access 2007 format. 

The Audit Trail module is compatible the following MS Access database formats: MS Access 97, MS 
Access 2000, MS Access 2003MS Access 2007, Access 2011 and Access 2013.

IMPORTANT  The AuditTrailCfg.exe configuration program does not have its own built-in access 
control. This means that, theoretically, any user who has access to the PC on which RheoWin was 
installed can start the configuration program and may make undesired modifications. Therefore, it 
is mandatory to restrict access to the configuration program.
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Figure 39. HAAKE Audit Trail Database Configuration; MS Access

The following parameters must be set in oder to be able to use an MS Access database:

• Database type
In case one of the two supplied MS Access database is to be used the entry MS Access 97 - 2003 or 
MS Access 2007 - 2013 must be selected.

• Path to database file
The path to the Audit Trail database file must be entered here. By default, the file 
HAAKEAuditTrail.accdb (MS Access 2007 - 2013 format) in the AuditTrail subdirectory of the 
RheoWin application data directory (see Installation directories) is set as the standard path. 
The database file does not necessarily need to have the file name HAAKEAuditTrail.accdb, it can 
be renamed as required.

• Username for database file
This field must be left blank in the case of an MS Access database. This function is currently not 
implemented (and also not required).

• Password for database file
In order to prevent unauthorized access to the Audit Trail database, for example via Microsoft 
Access, the database should be protected with a password. The password must be entered from this 
dialog to ensure that the password is known to RheoWin and that RheoWin is able to access the 
database file.

The (empty) HAAKEAuditTrail.mdb and HAAKEAuditTrail.accdb MS Access database files 
that are part of the installation do not contain a password.

Note  It is recommend to use the more modern MS Access 2007 - 2013 format.

IMPORTANT  For data protection reasons, it is strongly recommended to copy the 
HAAKEAuditTrail.mdb or HAAKEAuditTrail.accdb file to a network directory and set the 
path accordingly by clicking on the […] button.

Note  See the procedure “To set a password for the AuditTrail database file” on page 40.

IMPORTANT  Starting from RheoWin 4.95.0000 the password entered is automatically written 
to the MS Access database file.
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• Path to Emergency file
This file is used as a temporary log file in the event of loss of contact to the database file. Once 
access to the database file is restored, the file is automatically transferred to the database and then 
deleted.
It is recommended not to change the path to this file or at least to use a local path, i.e. no network 
path.

The following procedure describes how to set a password for the AuditTrail database file.

 To set a password for the AuditTrail database file

1. In the HAAKE Audit Trail Database Configuration dialog click the Change password button, see 
Figure 39, to open the Change Password dialog, see Figure 40.

When entering the password during the installation of RheoWin:

2. In the Change Password dialog leave the Old password edit field empty (since there is no old 
password).

When changing the password at a later point in time:

3. In the Change Password dialog enter the old password in the Old password edit field .

4. Enter the desired password in the New password edit field.

Figure 40. Change AuditTrail password question

5. Retype the desired password in the Retype new password edit field.

6. Click the Ok button to set the AuditTrail database password.

SQL database

An SQL database can be used as an alternative to an Access database. If this database already contains a 
table named "AuditTrail", the latter will be used without any preliminary check. This means that it 
must comply with the definitions as described in Database format. In case such a table does not yet 
exist, it will be created automatically. 

The following parameters must be set in case an SQL database is used:

• Database type
In case an SQL database is to be used, the corresponding entry must be selected here.

Click here to make the password 
characters visible
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• Path to database file
This entry has to consist of a server (IP address or host name) and a database file located a that 
point, separated by '\'. The [...] button has no function here. 
In case the database already contains a table called “AuditTrail”, this will be used without any 
preliminary check, this means that it has to meet the definition as described in Database format
If such a table does not exist, it will be created automatically.

• Username for database file
In case a user name is needed in order to access the SQL database it can be entered in this field.

• Password for database file
In case a password is needed in order to access the SQL database it can be entered in this field.

• Path to Emergency file
This file is used as a temporary log file in the event of loss of contact to the database file. Once 
access to the database file is restored, the file is automatically transferred to the database and then 
deleted.
It is recommended not to change the path to this file or at least to use a local path, i.e. no network 
path.

Database format
The RheoWin Audit Trail tool supports two database formats: Microsoft Access 97 up to 2013 and 
Microsoft SQL (starting from SQL Server 6.5). An empty Access database file with an Audit Trail table 
as shown in table 2 is supplied and automatically installed. In case an SQL database is used, we 
recommend to provide the database without an Audit Trail table entry so that the Audit Trail tool can 
automatically create the correct matching table.

Table 2 shows the AuditTrail table format.

IMPORTANT  The entered user name is not automatically written into the SQL database file. 
This needs to be done manually by the Windows system administrator.

IMPORTANT  The entered password is not automatically written into the SQL database file. 
This needs to be done manually by the Windows system administrator.

Table 2. Audit Trail table format

Column name Meaning Type 
(Access)

Type 
(SQL)

_HostID Name of the logged-in user plus the network name of the computer char[255]

_TimeOfDay Date and time of the entry in IEEE-Format (jjjjmmtt hh:mm:ss) char[255]

_Application Name of the program (e.g. „RheoWin JobManager“) char[255]

_Username User logged into the application (possibly not the same as _HostID) char[80]

_Theme Higher level subject of the action („User Management“, „Job“, ...“) char[255]

_Activity Action carried out („Login“, „Logout“, Load“, „Save“, ...) char[255]

_Filename Name of the affected file (Job file name, data file name, ...) text

_P1 Additional parameter 1 text
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The following gives a more detailed description of the meaning of the individual columns in the audit 
trail table:

• _HostID
is generated on the basis of the name of the PC on which RheoWin is installed and the respective 
Windows user currently logged into the system and has the format "User@Computer“, such as, for 
example, "Smith@PC-LABORATORY“. Here “Smith" is the name of the user who is logged into 
Windows (and is not necessarily identical with the user of the application), and 
“PC-LABORATORY” is the name of the computer in the network.

• _TimeOfDay
contains the date of the entry in the IEEE date/time format ("20031103“ for November 3rd, 
2003) and the time in 24-hour format.

• _Application
is the name of the Windows application that generated the entry, i.e. RheoWin Job Manager, 
RheoWin Data Manager or RheoWin User Administration System.

• _Username
is the name of the user logged into RheoWin.

• _Theme
is the subject to which the entry belongs (“Job Manager“, “Job Run“, etc.).

• _Activity
is the action carried out („User login“, „Load Job“, „Job Start“, etc.) 

• _Filename
If a file is involved, its name is specified here. This is the case, for instance, if a job is being loaded 
or saved, but not when a user is logging in. 

• _P1/_P2
Depending on the activity, several different parameters can be mentioned. For example the old an 
the new value of a certain measurement parameter.

• _Manipulated
This column ought to be always empty because it indicates manipulated data sets. These can occur 
when the temporary log file is illegally altered by means of an external editor.

Audit Trail viewer
The Audit Trail database can be displayed at any time in the HAAKE Audit Trail Viewer. The Audit 
Trail Viewer can either be started from the RheoWin Job Manager and RheoWin Data Manager by 
using the Audittrail Viewer command in the Programs menu or directly as a separate program named 
TrailView.exe. The TrailView.exe is stored in the RheoWin program directory (default directory: 
C:\Program Files\Thermo\RheoWin).

_P2 Additional parameter 2 text

_Manipulated *** (in case the data set in the temporary file was manipulated) char[5]

Table 2. Audit Trail table format

Column name Meaning Type 
(Access)

Type 
(SQL)
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Figure 41. HAAKE Audit Trail Viewer (with column Application hidden)

Because the Audit Trail Viewer program does not offer any editing and storage functions, it is 
impossible to make changes to the Audit Trail database using this application.

Data filtering

The Audit Trail Viewer offers filter functionality for each column, it is also possible to hide one or 
multiple columns completely.

 To activate a filter for a column

1. Click on a column header to open the Filter Columns dialog 

2. In the Filter Columns dialog select one or multiple filter entries from the list and click Ok. 

Columns for which a filter is active are marked with a * behind the column name.

When filters are defined for multiple columns at the same time, the audit trail will be filtered 
according to all filters.

 To deactivate a filter for a column

1. Click on a column header to open the Filter Columns dialog 

2. In the Filter Columns dialog select the <Show all> entry from the list and click Ok. 

or

3. Click on the Reset filter icon  in the toolbar.



 To hide/show a column

1. Right click on the column header of any column to open the Hide/show Columns dialog.

2. In the Hide/show Columns dialog activate or deactivate the check box for the column which 
should be shown or hidden.

Exporting the audit trail

The content of the Audit Trail database can be exported to a .CSV or a .PDF file.

 To export to a .CSV file

1. Select the File > Export to .CSV file command from the main menu to open the Save as dialog.

2. Enter a filename and click the Save button.

 To export to a .PDF file

1. Select the File > Export to .PDF file command from the main menu to open the Export to PDF 
dialog.

2. In the Export to PDF dialog select the desired format options, then click the [ ... ] button to open 
the Save as dialog.

3. Enter a filename and click the Save button to close the dialog.

4. Click the Export button in the Export to PDF dialog to create the PDF file.

Printing the audit trail

The Audit Trail Viewer can not directly print the contents of the Audit Trail database.

 To print the Audit Trail database content

1. Export the Audit Trail database content to a .CSV file or .PDF file.

2. Load the exported .CSV file with Excel (or any other suitable program).

or

3. Load the .PDF file in a PDF viewer.

• Use the printing functionality of the chosen program to print the Audit Trail database content.

Note  The export file will contain the same (filtered) information as displayed in the visible 
columns in the Audit Trail Viewer main window.

WARNING    The Audit Trail database can contain a very high number of entries (lines), 
printing the complete contents of the Audit Trail database may need a large quantity of paper.
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6

Signatures and security settings

The tool for the electronic signing of job and data files as well as some special security tools are 
described in this chapter are part of the 21 CFR Part 11 tools and will only be installed if an installation 
of the 21 CFR Part 11 tools is performed.

Settings for signatures
In RheoWin it is possible to electronically sign job, data, and page files (*.rwj, *.rwd, *.rwp). The use 
of electronic signatures is not mandatory according to the 21 CFR Part 11.

In RheoWin an electronic signature consists of the following attributes: 

• The login name of the logged-in RheoWin user.

• The user name of the logged-in RheoWin user.

• The system date and time.

• The meaning of the signature with the criterion OK or Not OK.

The settings for the electronic signatures must be made (once) on the Security options page of the 
Settings dialog. This dialog can be accessed using the Settings command in the Configuration menu 
of the RheoWin JobManager or RheoWin DataManager.

Note  In a standard RheoWin installation (i.e. without 21 CFR Part 11 tools), the (Signature and 
Save options, see Figure 42) tools described in this section are not installed and can, therefore, not 
be used.

Note  The functionality in the Inactivity timeout area in the Security options dialog (see 
Figure 42) is always available, that is, not exclusively part of the 21 CFR part 11 tools.
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Figure 42. Security options

•  Sign count
The Sign count number defines the number of signatures that is required for each file type (job, 
data or page file) to complete the signing process for a file (and thus finalize it). The default value 
for all file types is "1". The maximum number of signatures per file type is 5.
Each signature must be applied by a different user, a user can not apply multiple signatures to one 
file. A file can (must) be signed as often as required until the preset number of signatures has been 
reached. The file is then locked, which means that it can no longer be modified (see Signatures in 
JobManager and Signatures in DataManager).

• Meaning
A signature must always have a Meaning. A user can, for example, sign a file as the Author, 
another user can inspect the file (Review) and mark it as Ok, and a third user can approve the file 
(Approval) or reject it (Rejection). Because the process may differ depending on the company, the 
meanings of signatures can be modified (added or removed) and thus also be adapted to different 
languages.
To add a Meaning text, the text is first entered in the input field, it must be then be selected (from 
the Ok / Not Ok drop down list) whether the Meaning is a confirmation (Ok) or a rejection (Not 
Ok). After clicking the Add button the new Meaning is added to the list and is available for the 
signatures.
By selecting a Meaning in the list and clicking the Remove button, the meaning is removed from 
the list.

Save options
In the Save options box it can be selected whether or not the user has to enter a reason for the changes 
made in a (job or data or page) file whenever the file is saved. If this option is enabled, the user is forced 
to enter a text justifying the changes made in a data entry dialog box every time he saves a job, data or 
page file. This reason is stored in the Audit Trail with the relevant file entry.
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Figure 43. Enter reason for change

When the 21 CFR Part 11 tools are installed these three options must be enabled .

Deactivation in case of inactivity
In the box Deactivation in case of inactivity, the option Deactivation of program after n min 
without user activity can be enabled. When this option is enabled RheoWin will be locked after n 
minutes of user inactivity (i.e. without mouse click activity or keyboard input). Once the mouse is 
clicked again or a keyboard input is attempted, the RheoWin login dialog will be displayed and the 
user must login using his login name and password. A job (measurement) that is already inmidst of 
execution will continue to run even when the RheoWin user interface is locked.

This function is only available in RheoWin versions starting from 4.10.0000, that means that it is not 
implemented in older versions.

Signatures in JobManager
In the RheoWin JobManager *.rwj job files can be electronically signed when the job is opened for 
editing in the Job Editor.

Signing jobs

A job (that has not yet been completely signed yet) can be signed by selecting the command Sign job 
from the File menu of the JobManager or by clicking the  Button in the toolbar of the 
JobManager or by selecting the command Sign job from the (right mouse-key) context menu in the 
Job Editor.

These menu items and buttons are only active when the currently logged-in user has been granted the 
privileges to sign jobs and the job is not yet completely signed yet.

As long as a Job is not signed the text Job not signed is displayed in the Job Editor status bar (see 
Figure 44).
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Figure 44. Job Editor status bar, no signature applied

In the Sign job dialog, a user (the currently logged-in user is pre-selected) must select his login name, 
enter his Password and choose the Meaning for the signature in order to to sign a job.

Figure 45. Signing a job

After clicking the Ok button, the signature is added to the job file and the job file is saved. In case the 
job file was not yet saved before attempting to sign the job, for example because the job was just 
created, the File save dialog will be opened, before the Sign job dialog was opened, and a file name 
must be selected first.

The signing of a job file is recorded in the Audit Trail.

It is not possible to remove a signature from a job file.

As soon as a job file contains at least one signature, it can not be modified anymore, only additonal 
signatures can be entered.

If one or multiple signatures have been entered, but not yet the defined maximum number of 
signatures, the texts Job signed and Signatures x of y are displayed in the Job Editor status bar (see 
Figure 46).

Figure 46. Job Editor status bar, signature(s) applied

When the define maximum number of signatures has ben entered, the texts Job locked and 
Signatures y of y are displayed, indicating that the job file is now locked and approved or rejected (see 
Figure 47).

Figure 47. Job Editor status bar, job locked

Status bar

Status bar

Status bar



 6 Signatures and security settings
Signatures in DataManager

Thermo Scientific HAAKE RheoWin installation and 21 CFR Part 11 configuration 49

Displaying the signatures

The signatures entered in a job file can be displayed in a separate window by clicking on the Signature 
x of y text in the Job-Editor status bar or by selecting the Display signature command from the (right 
mouse button) context menu of the Job Editor.

Figure 48. Signatures

Modifying a signed job

A completely signed (locked) job files cannot be modified anymore. 

In case a completely signed (locked) job file needs to be modfied it must be saved under a different 
name, by using the Save as command, first. The thus created new job file will not contaian any 
signatures and can be modified. 

Copying a job file will result in an entry in the AuditTrail.

Signatures in DataManager
In the RheoWin DataManager *.rwd data files and *.rwp page files can be electronically signed from 
the File menu.

Signing data files and page files

A data or page file (that has not yet been completely signed yet) can be signed by selecting the 
command Sign file from the File menu of the DataManager

These menu item (command) is only active when the currently logged-in user has been granted the 
privilege to sign data and page file and the data or page file is not yet completely signed.

Figure 49. Signing a (data or page) file

In the Sign file dialog, a user (the currently logged-in user is pre-selected) must select his login name, 
enter his Password and choose the Meaning for the signature in order to sign a data or page file.

After clicking the Ok button, the signature is added to the file and the file is saved.
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The signing of a data or page file is recorded in the Audit Trail.

It is not possible to remove a signature from a data or page file.

As soon as a data or page file contains at least one signature, it can not be modified anymore, only 
additonal signatures can be entered.

Displaying the signatures

The signatures entered in a data or page file are directly displayed in the information window under the 
corresponding file name. The signatures are also shown in a report print-out.

Editing signed data files and page files

Once a job or page file has been signed at least once, it it not possible anymore to make any further 
changes to that file in the DataManager, evaluation data can not be added or deleted anymore.

In case a completely signed (locked) data or page file needs to be modfied it must be saved under a 
different name, by using the Save as command, first. The thus created new data or page file will not 
contain any signatures and can be modified.

Copying a data or page file will result in an entry in the AuditTrail.



Thermo Scientific HAAKE RheoWin installation and 21 CFR Part 11 configuration 51

A

Directories, files, registry

Windows registry key
RheoWin stores all settings, parameters, paths, etc. under the following Windows registry key only 
(this applies to all versions of Windows):

HKEY_USERS\.DEFAULT\Software\Thermo\RheoWin

All Windows users that want to use the RheoWin software must have read and write permissions for 
this registry key.

Installation directories
RheoWin consists of many files which are stored various different directories. Information on which 
files are stored in which directories can be found below. 

Directories for program *.exe, *.dll, etc. files

The default main RheoWin program directory is,

for english and other language 32-bit Windows versions:

C:\Program Files\Thermo\RheoWin

for english and other language 64-bit Windows versions:

C:\Program Files(x86)\Thermo\RheoWin

for german language 32-bit vWindows versions:

C:\Programme\Thermo\RheoWin

for german language 64-bit Windows versions:

C:\Programme(x86)\Thermo\RheoWin

All *.exe, *.dll files belonging to RheoWin are stored in this directory and the corresponding 
subdirectories. Although it is possible to select another directory for the main RheoWin program 
directory during the installation, it is not recommended to do so.
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Directories for program data files

All RheoWin program data files are stored in the following directory and its subdirectories (this 
directory can not be changed).

Directory for english and other language Windows XP versions:

C:\Documents and Settings\All Users\Application Data\Thermo\RheoWin

Directory for german Windows XP versions:

C:\Dokumente und Einstellungen\All Users\Anwendungsdaten\Thermo\RheoWin

Directory for all Windows 7, Windows 8(.1) and Windows 10 versions (language independent):

C:\ProgramData\Thermo\RheoWin

Program data files are files that are automatically created and changed by RheoWin, i.e. without direct 
intervention of the user. Normally it is not necessary that users have direct access to these files. 

Table 3. Directories for RheoWin program data files

Directory File(s) Usage

\RheoWin Rheowin.log RheoWin program log file, for debugging only

\RheoWin\Elmdll elmdll.ini ini file for the RheoWin job-elements, for setting special 
options only

\RheoWin\Drivers drivers.flp in this file are almost all device settings that can be made in 
the RheoWin DeviceManager are stored

drivers.ini ini file for devices, for setting special options only

*.log communication log files, for debugging only

*.err communication error files, for debugging only

*.msc exported MSC table files

*.mtc exported MTC table files

*.tot exported TOT table files

\RheoWin\Autosave autosave.rwd automatically saved copy of the last measured data file

Drivers_Autosave_x.xx.xx.flp automatically saved copy of the last Drivers.flp file

Drivers_Setup_x.xx.xx.flp automatically saved copy of the setup Drivers.flp file

\RheoWin\UMS UMS.mdb The User Management System data base file

\RheoWin\Audittrail HAAKEAudittrail.mdb The MS Access Audit Trail data base file

Note   In order to be able to view the directories listed above in the Windows Explorer, they must 
first be made visible. This requires that the Show hidden files, folders or drives option is enabled 
on the View page of the Folder options dialog in the Windows Explorer. 
Under Windows XP: The Folder options dialog can be opened via the Folder options command 
in the Tools menu. 
Under Windows 7, Windows 8(.1) and Windows 10: The Folder options dialog is opened via the 
Folders and search options command in the Organize menu.



 A Directories, files, registry
Installation directories

Thermo Scientific HAAKE RheoWin installation and 21 CFR Part 11 configuration 53

Directories for user files

By default, RheoWin user files are stored in the following directory and its subdirectories (these 
directory can be changed by the user at any time).

Directory for english and other language Windows XP versions:

C:\Documents and Settings\All Users\Documents\Thermo\RheoWin.

Directory for german language Windows XP versions:

C:\Dokumente und Einstellungen\All Users\Gemeinsame Dokumente\Thermo\RheoWin

Directory for english and other language Windows 7, Windows 8(.1) and Windows 10 versions:

C:\Users\Public\Public Documents\Thermo\RheoWin 
(or C:\Users\Public\Documents\Thermo\RheoWin depending on the representation in the 
Windows Explorer)

Directory for german Windows 7, Windows 8(.1) and Windows 10 versions:

C:\Benutzer\Öffentlich\Öffentliche Dokumente\Thermo\RheoWin

User files are files that are created and modified by RheoWin through direct intervention of the user. 
The following file types fall under this category:

Table 4. Directories for user files

Directory File(s) Usage

\RheoWin\Job *.rwj Job files

\RheoWin\Data *.rwd Data files

\RheoWin\Page *.rwp Page files

\RheoWin\Report *.lst Report template files

\RheoWin\Template *.rwt Job template files

*.gds Graph template files

*.tds Table template files

*.rwl Page template files

\RheoWin\Media various Image, video and document files
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B

User privileges

In total, more than 170 user privileges can be assigned to every user. The privileges are sorted in four 
categories General, Signature, Job manager and Data manager as shown in Table 5. The individual 
privileges are described in Tables 6 until 26, the contents of these tables match the hierarchical tree 
structure in the Privilege selection tree in the Edit user dialog, see Figure 50.

Figure 50. Privilege selection in Edit User dialog

Table 5. Main user privileges categories

Checkbox name (= tree item)

RheoWin

RheoWin > General See “General privileges (in both Job- and DataManager)” on page 56
in Table 6, Table 7, Table 8, Table 9 andTable 10

RheoWin > Signature See “Privileges for Signatures (in Job- or DataManager)” on page 59
in Table 11

RheoWin > Job manager See “Privileges in JobManager” on page 59
in Table 12, Table 13, Table 14, Table 15, Table 16, Table 17, 
Table 18, Table 19, Table 20, Table 21

RheoWin > Data manager See “Privileges in DataManager” on page 62
inTable 22, Table 23, Table 24, Table 25, Table 26

Note  The second column in Table 6 to Table 26 only contains information when the relation 
between the checkbox name (in the first column) and the corresponding functionality is not 
directly obvious. 
In many cases the checkbox name in the first column directly corresponds with a menu item, 
button etc.

Tree structure
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General privileges (in both Job- and DataManager)
The privileges in Table 6 apply to commands in the Configuration menu of the JobManager and the 
DataManager main menu.

Table 6. Privileges below the General > Configuration tree item

Checkbox name (= tree item) Functionality (Dialog, Item, Button, etc.)

Language

Units Quantity / Units dialog

Units > Text instead of symbols

Units > Quantities / Units Quantity / Units page in dialog

Units > Quantities / Units > Change unit Applies to Unit button and list context menu

Units > Quantities / Units > Edit Applies to Add, Edit and Remove buttons

Units > Quantities / Units > Enable Applies to Enable and Disable buttons

Units > Quantities / Units > Import

Units > Quantities / Units > Export

Units > Quantities / Units > Replace

Units > Quantity groups Quantity groups page in the dialog

Units > Quantity groups > Change default Applies to Default button

Units > Quantity groups > Edit Applies to Add, Edit, Remove and Copy buttons

Units > Quantity groups > Import

Units > Quantity groups > Export

Units > Quantity groups > Replace

Preferences Preferences dialog

Preferences > Directories Applies to Directories page in dialog

Preferences > General Applies to General page in dialog

Preferences > Default settings Applies to Default settings page in dialog

Preferences > Protocol/Report Applies to Job information /Reporta page in dialog

a Only in Data Manager

Preferences > SAP Ascii Applies to SAP Asciib page in dialog

b Not available in all installations

Preferences > Security Applies to Securityc page in dialog

c Only available as part of the 21 CFR Part 11 tools

Preferences > Mail Applies to Mail page in dialog

User Manager

Symbol/Color master layout
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The privileges in Table 7 apply to commands in the Programs menu of the JobManager and the 
DataManager main menu.

The privileges in Table 8 apply to commands in the Help menu of the JobManager and the 
DataManager main menu.

The privileges in Table 9 apply to the Table layout dialog. This dialog is accessible in various different 
ways in Job Manager and Data Manager.

Table 7. Privileges below the General > Programs tree item

Checkbox name (= tree item)

Edit report

Report viewer

Audittrail viewer a

a Only available as part of the 21 CFR Part 11 tools

Edit

Table 8. Privileges below the General > Help tree item

Checkbox name (= tree item) Functionality (Dialog, Item, Button, etc.)

Internet Applies to Internet / Update menu item

Homepage Applies to Internet / Update > Home Page menu item

Update Applies to Internet / Update > Rheowin home page menu 
item

Contact Applies to Internet / Update > Contact menu item

Show log file

Table 9. Privileges below the General > Table tree item  (Sheet 1 of 2)

Checkbox name (= tree item) Functionality (Dialog, Item, Button, etc.)

Edit Applies to editing values in the table itself

Open layout

Open layout > Templates Applies to Templates page in the dialog

Open layout > Templates > Load Applies to Open button

Open layout > Templates > Save as Applies to Save as template button

Open layout > Templates > Remove Applies to Delete button

Open layout > Columns Applies to Columns page in the dialog

Open layout > Data Applies to Segments+Filter page in the dialog

Open layout > Data > Segments
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The privileges inTable 10 apply to the Graph layout dialog. This dialog is accessible in various 
different ways in Job Manager and Data Manager.

Open layout > Data > Filter

Open layout > General Applies to General page in the dialog

Table 10. Privileges below the General > Graphics tree item

Checkbox name (= tree item) Functionality (Dialog, Item, Button, etc.)

Open layout

Open layout > Templates Applies to Templates page in the dialog

Open layout > Templates > Load Applies to Open button

Open layout > Templates > Save as Applies to Save as template button

Open layout > Templates > Remove Applies to Delete button

Open layout > Axis Applies to Axis page in the dialog

Open layout > Scaling Applies to Scaling page in the dialog

Open layout > Data Applies to Data page in the dialog

Open layout > Data > Layout Applies to Layout page in Data page

Open layout > Data > Curves Applies to Curves page in Data page

Open layout > Data > Segments Applies to Segments page in Data page

Open layout > Data > Filter Applies to Filter page in Data page

Open layout > Grid + Graph Applies to Grid + Graph page in the dialog

Open layout > Legend + Text Applies to Legend + Text page in the dialog

Open layout > Marker Applies to Markera page in the dialog

a Accessible only when graph contains markers

Open layout > Marker> Layout

Open layout > Marker> Edit values

Open layout > Marker> Visible

Open layout > Marker> Remove

Table 9. Privileges below the General > Table tree item, continued (Sheet 2 of 2)

Checkbox name (= tree item) Functionality (Dialog, Item, Button, etc.)
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Privileges for Signatures (in Job- or DataManager)
The privileges Table 11 apply to the electronic signature functionality.

Privileges in JobManager
By disabling the privileg in Table 12 access to the Job Manager program is completely disabled.

The privileges in Table 13 apply to the commands in the File menu.

The privileges in Table 14 apply to ???

Table 11. Privileges below the Signature tree item

Checkbox name (= tree item)

File

File > Sign jobs a

a Only available in Job Manager as part of the 21 CFR Part 11 tools

File > Sign data b

b Only available in Data Manager as part of the 21 CFR Part 11 tools

File > Sign page b

Table 12. Privileges below the Job manager tree items

Checkbox name (= tree item) Functionality (Dialog, Item, Button, etc.)

Start Job Manager Applies to launching the Job Manager program

Table 13. Privileges below the Job manager > File tree items

Checkbox name (= tree item)

File > Wizard

File > New job

File > Open job

File > Open from device

File > Start device job

File > Save

File > Save as

File > Save as template

File > Save on desktop

File > Shortcut on desktop
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The privileges in Table 15 apply to the DeviceManager dialog and two commands in the 
Configuration menu.

The privileges in Table 16 apply to commands in the Programs and the Test menu in the JobManager 
main menu.

The privileges in Table 17 apply to the JobEditor dialog.

Table 14. Privileges below the Job manager > Job dialog tree items

Checkbox name (= tree item)

Job dialog > Open

Job dialog > Delete

Table 15. Privileges below the Job manager > Configuration tree item

Checkbox name (= tree item)

Device manager

Device manager > Add

Device manager > Edit

Device manager > Remove

Device manager > Rename

Device manager > Copy

Device manager > Test

Device manager > Diagnosis

Device manager > Inertia

Device manager > MSC

Device manager > Import

Device manager > Export

Device manager > Replace

Restore devices

Restore devices > Automatic

Restore devices > From file

Table 16. Privileges below the Job manager > Programs and Job manager > Test tree items

Checkbox name (= tree item)

Programs > Data manager

Test > Snapshot
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The privileges in Table 18 applies to starting a Job from a JobEditor or using the JobRun program.

The privileges in Table 19 apply to the Job elements, Jobs and Template explorer.

Table 17. Privileges below the Job manager > Job editor tree item

Checkbox name (= tree item) Functionality (Dialog, Item, Button, etc.)

Rheometer Applies to Rheometer selection drop-down list

Measuring geometry Applies to Measuring geometry selection drop-down list

Edit gap Applies to Gap edit field

Temperature controller Applies to Temperature controller selection drop-down list

Display Applies to Display button

Identification Applies to Indentification button

Filename Applies to Filenamebutton

Manual control Applies to Manual control button

Upload Applies to Uploada button

a Only available for certain (older) instruments

Edit elements Applies to editing the parameters of job elements

Change element sequence Applies to changing the position of a job element in a job

Table 18. Privileges below the Job manager > Start jobs tree items

Checkbox name (= tree item) Functionality (Dialog, Item, etc.)

Jobs Applies to starting a Job

Signed job Applies to starting a signed Job a

a Only available as part of the 21 CFR Part 11 tools

Table 19. Privileges below the Job manager > Elements/Job/Template Explorer tree item  (Sheet 1 of 
2)

Checkbox name (= tree item) Functionality (Dialog, Item, etc.)

Elements

Elements > Configuration Applies to Elements configuration command in the context 
menu and in the Configuration menu.

Elements > Configuration all users see above

Open job/template Applies to opening a Job file or Template file

Delete job/template Applies to deleting a Job file or Template file
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The privileges in Table 20 apply to commands in the Help menu of the JobManager main menu.

The privileges in Table 21 apply to buttons in the JobController dialog.

Privileges in DataManager
By disabling the privileg in Table 22 access to the DataManager program is completely disabled.

The privileges in Table 23 apply to the commands in the File menu and the corresponding buttons in 
the toolbar.

Change job/template root 
directory

Applies to selecting another Job or Template directory

Move, Rename, New folder Applies to moving a Job file or a Template file to another 
directory, renaming files/directories and creating a new 
directory

Table 20. Privileges below the Job manager > Help tree items

Checkbox name (= tree item)

Help > Edit ini files

Table 21. Privileges below the Job manager > Job Controller tree item

Checkbox name (= tree item)

Go to next element Applies to Next button

Accept current measurement value Applies to Accept button

Accept current temperature Applies to temperature Accept button

Save current data Applies to Save button

Allow overwriting data file Allows for overwriting an existing data file by a Job.
This option must be deactivated for 21 CFR Part 11.

Table 19. Privileges below the Job manager > Elements/Job/Template Explorer tree item, continued, 
continued (Sheet 2 of 2)

Checkbox name (= tree item) Functionality (Dialog, Item, etc.)

Table 22. Privileges below the Data manager tree items

Checkbox name (= tree item) Functionality (Dialog, Item, etc.)

Start Data Manager Applies to launching the DataManager program
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The privileges in Table 24 apply to the commands in the Analysis menu and the corresponding 
buttons in the Analysis toolbar.

Table 23. Privileges below the Data manager > File tree items

Checkbox name (= tree item)

New

Open file

Open last measurement

Page

Page > Open page

Page > Save page

Page > Save page as

Saves as

Save all

Identification

Print report

Report preview

Save

Print

Table 24. Privileges below the Data manager > Analysis tree item  (Sheet 1 of 2)

Checkbox name (= tree item)

Curve fit

Curve discussion

Thixotropy

Interpolation

Area

Creep analysis

Yield stress

Crossover

SHRP

Recalculate all

Advanced curve discussion

Reference

Structure recovery

LVB
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The privileges in Table 25 apply to commands in the Programs menu in the DataManager main 
menu.

The privileges in Table 26 apply to the Data, Pages and Templates explorer.

TTS

Spectra

MWD

Mean and Merge

Calculate derivation

Bitumen

Bitumen > MSCR

Bitumen > BYET

Bitumen > LAS

Powder Rheology

Powder Rheology> Powder Flow

Powder Rheology> Powder Shear

Table 25. Privileges below the Job manager > Programs tree items

Checkbox name (= tree item)

Job manager

Table 26. Privileges below the Data manager > Data/Page/Template explorer tree item

Checkbox name (= tree item)

Open data Applies to opening a data file

Delete data Applies to deleting a data file

Change data root directory Applies to selecting another data file directory

Move, Rename, New folder Applies to moving a data or page or template file to another 
directory, renaming files/directories and creating a new directory

Open page Applies to opening a page file

Delete page Applies to deleting a page file

Change page root directory Applies to selecting another page file directory

Open template Applies to applying a template to graph, table or page

Delete template Applies to deleting a template file

Change template root directory Applies to selecting another template file directory

Table 24. Privileges below the Data manager > Analysis tree item, continued (Sheet 2 of 2)

Checkbox name (= tree item)
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C

Configuration of Windows permissions

Windows and RheoWin versions
The configuration described in this appendix may be needed for the installation of RheoWin under 
Windows 7, Windows 8(.1) and Windows 10. Whether this configuration is needed depends on things 
like Windows group policies and other Windows security setting, which differ from company to 
company.

The configuration described in this document is not needed for the installation of RheoWin version 
4.00.0000 and all newer versions under Windows XP.

The RheoWin ProgramData directory
RheoWin stores many program specific settings and parameters in so-called programdata files in the 
following directory and its subdirectories (as recommended by Microsoft).

Directory for RheoWin programdata files: c:\ProgramData\Thermo\RheoWin

Programdata files are files which are automatically (i.e. without direct action of the user) created and 
modified by RheoWin. Examples for programdata files are the file drivers.flp, in which all settings of 
the RheoWin DeviceManager are saved and the file UMS.mdb, the UserManagement database file.

RheoWin must have unrestricted read- and write-access to the above mentioned directory and all of its 
subdirectories for all Windows users. When this is not the case it is possible that, depending on the 
Windows security settings, certain Windows users can not start RheoWin at all or that RheoWin does 
not access the correct directory (with the consequence that certain RheoWin settings and parameters 
do not have the correct values).

When the Windows User Account Control Settings are not set to lowest level (see the screenshot 
below) and at the same time the permissions for the RheoWin programdata directory are not set 
correctly, Windows may create a copy of the RheoWin programdata directory in the so-called Virtual 
Store directory (for each Windows user separately).

In this case all RheoWin access to the files in the RheoWin programdata directory is automatically 
redirected to the files in the copy of the programdata directory in the Virtual Store without RheoWin 
or the Windows user being informed.

Note  Under normal circumstances RheoWin users do not need direct access to these files.
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The result of this is, amongst other issues, that RheoWin does not access the same UserManagement 
database file and RheoWin DeviceManager settings anymore, which is definitively not the desired 
behavior.

In order to prevent this from happening the Windows permissions for the RheoWin programdata 
directory must configured correctly.

The configuration described below is valid for all possible settings in the Windows User Account 
Control Settings dialog.

The Windows User Account Control and Virtual Store
Although the actual settings in the Windows User Account Control Settings dialog do not influence 
the RheoWin functionality, as long as the permissions for the RheoWin programdata directory are 
correctly configured, is it useful to be informed about these settings.

 To open the User Account Control Settings dialog

4. In the Windows Start menu click on Control Panel.

5. In the Search Control Panel edit field, see Figure 51, enter the text UAC.

Figure 51. Search edit field in Control panel

The contents of the dialog will then change automatically while the text is entered, see Figure 52.

6. Click the Change User Account Control settings hypertext, see Figure 52, to open the User 
Account Control Settings dialog (see Figure 52).

Figure 52. Change User Account settings

When the vertical slider in the User Account Control Settings dialog is not in the lowest position 
and the Windows permissions for the RheoWin programdata directory are not configured 
correctly, Windows may use copies of the RheoWin programdata directory (for each Windows 
user individually) in the Windows Virtual Store, which will result in undesired behavior of 
RheoWin.

Search edit field

Change User Account Control settings hypertext
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Figure 53. User Account Control Settings

Making the C:\ProgramData folder visible
By default the folder C:\ProgramData is not visible in the Windows explorer.

 To make the C:\ProgramData folder visible

1. In the Windows Explorer select Organize in the main menu.

2. In the Organize menu select the Folder and search options command, to open the Folder 
Options dialog, see Figure 54

3. In the Folder Options dialog select the View page, see Figure 54.

Note  For a Windows user with the name [Windows-User], the RheoWin programdata 
subdirectory in the Virtual Store, is located (when it exists) in the following directory: 
C:\Benutzer\[Windows-User]\AppData\Local\VirtualStore 

IMPORTANT  In order for RheoWin to work correctly there must no subdirectory 
\ProgramData\Thermo\RheoWin\ in the above mentioned Virtual Store directory.

Vertical slider
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Figure 54. Folder options

4. In the Advanced settings list scroll down until the entry Show hidden files, folders and drives 
becomes visible, see Figure 54.

5. Activate the Show hidden files, folders and drives option.

6. Click the OK button to close the dialog.

7. In case the C:\ProgramData folder is not visible in the Windows Explorer after closing the Folder 
Options dialog, close and open the Window Explorer again.

Configure the permissions for the C:\ProgramData\Thermo\RheoWin 
directory

The directory C:\ProgramData\Thermo\RheoWin must now be configured such that RheoWin has 
unrestricted read- and write-access to this directory for all Windows users.

 To configure the C:\ProgramData\Thermo\RheoWin directory

1. In the Windows Explorer select the directory C:\ProgramData\Thermo\RheoWin with the right 
mouse key to open the directory context menu, see Figure 55.

IMPORTANT  This configuration should be performed before the first start of RheoWin.
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Figure 55. Directory context menu

2. In the context-menu select the Properties command at the bottom of the menu (see Figure 55) to 
open the RheoWin Properties dialog (see Figure 56).

Figure 56. RheoWin Properties

3. In the RheoWin Properties dialog click the Edit... button (see Figure 56), to open the 
Permissions for RheoWin dialog (see Figure 57).

Properties commannd

Edit ... button
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Figure 57. Permissions for RheoWin

4. In the Permissions for RheoWin dialog click the Add… button (see Figure 57), to open the 
Select Users, Computers, Service Accounts or Groups dialog (see Figure 58).

Figure 58. Select Users, Computers, Service Accounts or Groups

5. In the Select Users, Computers, Service Accounts or Groups dialog (see Figure 58) click the 
Object Types… button to open the Object Types dialog (see Figure 59).

Figure 59. Object types

6. In the Object Types dialog, in the Object types list, deactivate all object types apart from the type 
Built-in security principals (see Figure 59).

7. Click the OK button to close the Objekt Types dialog to put the Select Users, Computers, Service 
Accounts or Groups dialog in focus again (see Figure 60).

Add... button

Object Types button
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Figure 60. Select Users, Computers, Service Accounts or Groups
pkwpkw

8. In the Select Users, Computers, Service Accounts or Groups dialog click the Advanced… 
button.

The dialog will then be displayed in a modified version, see Figure 61.

Figure 61. Select Users, Computers, Service Accounts or Groups (modified)

9. In the (modified) Select Users, Computers, Service Accounts or Groups dialog click the Find 
Now button. 

The search result will then be displayed in the Search results list, see Figure 62.

Advanced button

Find Now button
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Figure 62. Select Users, Computers, Service Accounts or Groups (modified)

10. In the Search result list in the (modified) Select Users, Computers, Service Accounts or Groups 
dialog select the entry Authenticated Users and click the OK button.

The dialog will then be displayed in the original version again (see Figure 63).

Figure 63. Select Users, Computers, Service Accounts or Groups

11. In the Select Users, Computers, Service Accounts or Groups dialog (see Figure 63) click the OK 
button to close the dialog.

In the Permissions for RheoWin dialog the group name Authenticated Users is now added to 
the Group or user names list, see Figure 64.
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Figure 64. Permissions for RheoWin

12. In the Permissions for RheoWin dialog in the Permissions for Authenticated Users list activate 
the options Full control Allow and Modify Allow (see Figure 64 and Figure 65).

Figure 65. Permissions for RheoWin

13. Click the OK button to close the dialog.

In the RheoWin Properites dialog (see Figure 66) the group name Authenticated Users is now 
added to the Group or user names list with the permission set above.

Full control allow and Modify allow
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Figure 66. RheoWin Properties

14. In the RheoWin Properties dialog (see Figure 66) click the OK button to close the dialog. 

The Windows permissions for the directory C:\ProgramData\Thermo\RheoWin are now 
configured such that RheoWin can be used correctly by all Windows user.

IMPORTANT  When the configuration described above is performed after RheoWin was started at 
least once, the \ProgramData\Thermo\RheoWin subdirectories in the Virtual Store must be 
deleted for all Windows users. This because, despite all configuration efforts, Windows will 
continue to use these directories for RheoWin as long as they exist.
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